Login Properties

- **User Name** – The name of the Login.
  - Your *Sage 300 Intelligence* logon credentials will be required
- **Password** – *Sage 300 Intelligence* password will be required.

![Login Properties form]

- **Server** - <local machine>
- **User ID** - ADMIN
- **Password** - [Password field]
- **Company** - Sample Company Ltd.
- **Session Date** - 2010/06/11
Accessing the Sage 300 ERP Intelligence Reports

To access the reports:

1. In Windows, Click on All Programs, Sage 300 ERP, Sage 300 ERP Intelligence.

2. Click on Report Manager or Report Viewer

   ![Report Manager and Viewer buttons](image)
Running a Report

1. Select the report you want to run. For this example, choose Sales Master under Sales.

2. To run the report click on the green Run icon, You can also right-click and select Run or press Ctrl+R

3. Enter Report Parameter. (Date/ Month)

4. Click OK

5. The progress Status is displayed on the right of your screen and indicates the process of your report. Depending on the size of your company data, running a report may take some time. You can sometimes cancel the report.

6. Once the process has finished, the report opens in a new Microsoft Excel Workbook
# Sample Company Inc.

**SALES MASTER**

For the period from 01 Jan 2020 to 31 Dec 2020

<table>
<thead>
<tr>
<th>CUSTOMER</th>
<th>ITEM CODE</th>
<th>ITEM NAME</th>
<th>QTY</th>
<th>Total Cost</th>
<th>Total Est Amount</th>
<th>Total Discounts</th>
<th>Sales Excl</th>
<th>GP</th>
<th>GP %</th>
</tr>
</thead>
<tbody>
<tr>
<td>1200</td>
<td>A1100</td>
<td>Fluorescent Desk Lamp</td>
<td>100</td>
<td>2,281.70</td>
<td>7,009.80</td>
<td>7,008.80</td>
<td>472.72</td>
<td>67</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1200</td>
<td>Halogen Desk Light</td>
<td>3.00</td>
<td>76.31</td>
<td>151.05</td>
<td>151.05</td>
<td>74.74</td>
<td>49</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1300</td>
<td>50W/12V Halogen Bulb</td>
<td>2.00</td>
<td>117.40</td>
<td>204.80</td>
<td>204.80</td>
<td>97.05</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1400</td>
<td>Desk Note Book</td>
<td>3.00</td>
<td>235.44</td>
<td>718.50</td>
<td>718.50</td>
<td>513.00</td>
<td>69</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1500</td>
<td>Bulletin Board</td>
<td>15.00</td>
<td>117.72</td>
<td>205.50</td>
<td>205.50</td>
<td>147.70</td>
<td>66</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1600</td>
<td>Answering Machine</td>
<td>10.00</td>
<td>103.25</td>
<td>309.75</td>
<td>309.75</td>
<td>251.05</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A1700</td>
<td>Personal Digital Assistant</td>
<td>5.00</td>
<td>541.25</td>
<td>1,799.75</td>
<td>1,799.75</td>
<td>1,250.70</td>
<td>70</td>
<td></td>
</tr>
</tbody>
</table>

| 1240     | A1100      | Fluorescent Desk Lamp    | 363  | 3,449.95   | 9,602.35         | 9,602.35       | 191.40    | 64     |
|          | A1200      | Halogen Desk Light       | 15.00| 381.55     | 755.25           | 755.25         | 373.07    | 49     |
|          | A1300      | 50W/12V Halogen Bulb     | 97.00| 355.95     | 619.63           | 619.63         | 263.68    | 43     |
|          | A1400      | Desk Note Book           | 190.00| 734.82    | 2,495.00         | 2,495.00       | 1,710.18  | 68     |
|          | A1500      | Desk Calendar Pad        | 78.00| 485.50     | 1,247.22         | 1,247.22       | 761.72    | 61     |

Grand Total | 546.00 | 5,722.73 | 16,011.15 | 16,011.15 | 16,008.42 | 66 |

---

Sage 300 ERP Business Intelligence

May-12
Copying, Pasting and Renaming Reports

You can copy and paste a report, at any stage, in the report manager. These functions are useful in Sage 300 ERP Intelligence because all the Master reports are locked and you need to make a copy of these master reports. Use the copy, paste, and renaming methods so you can create new reports from an existing report and therefore not corrupt the master report.

You may have a sales report that shows a customer analysis on sales; however, you want to create another report that shows sales analyzed by Reps. You can create a copy of the original report, and then rename the copy to Sales by Rep, and then customize the new Sales by Rep report. You have the benefit of re-using all the containers and expressions in the original report without having to create them from scratch.

To create a new report from an existing report

1. Open the Report Manager.
2. Right-click on the report you want to make a copy of; e.g. Sales Analysis
3. Select Copy to copy that report to the Clipboard.
4. Now paste the copied report onto a folder.

5. Select a folder. You can choose the same folder that contains the original report or a different folder.

6. Right-click on the selected folder and select Paste.

7. Rename the newly copied report. By default, the report’s name is Copy of <report name>.

   **Note** – You can use the short-cut keys of Ctrl+C to copy the report, and Ctrl+V to paste instead of using the menus.
Right-click on the report and select **Rename** to give the report a different name. You now have an exact duplicate of the original report that will obtain its data from the same place, and deliver it in the same format, until you make any changes to this new report.
Creating and Linking a Report

It is entirely possible to customize the look and layout of the Sage 300 ERP Intelligence Standard Reports. Although these reports are designed to encompass the needs of most business organizations, you may want to change the appearance (colors, text style, etc.) to reflect your company image, and perhaps change the order or inclusion of columns to suit your company processes. These changes can be saved for the next time you run the report.

Creating Excel templates enables the user to create a template from an open Excel workbook and link it to an existing report so as to standardize the output format of the chosen report for every run instance in future.

Note: If you are unsure of making changes to any of the Standard Reports, you should create a copy of the report before you make any changes.

Sage 300 ERP Intelligence users must make a copy of a report in order to edit the standard reports.

To copy a report

1. Open the Sage 300 ERP Intelligence Report Manager.
2. Right-click the report you want to copy and select Copy.
3. Right-click on the report folder in which you want to paste the copy and select Paste. The copy of the report is renamed as Copy of and the original report name.

To create and link the Report

1. Open the Sage 300 ERP Intelligence Report Manager.
2. Select and run the report you want to customize; e.g., Copy of Sales Master.
3. Make the changes to the report; ensure that Sheet1 (where Sage 300 ERP Intelligence puts the Raw Data) and Sheet2 (where Sage 300 ERP Intelligence puts the report parameters) are unchanged.
4. After completing the changes, leave the workbook open and go back to the Report Manager.

5. Right-click on the report for which the changes were made and select **Create and Link Template**.

6. Select the workbook with the changes in the window that appears.

7. Click **OK**.
8. When prompted with the following message, click Yes to link the workbook. Clicking No will not link the workbook.

9. When prompted to specify the template name, change the name of the template. Doing so ensures that the original template is not overwritten with the copy.

10. Click OK.

Once the template has been successfully linked, a message is displayed.
Adding & Creating a New report

To create a new report from existing containers, you must first create a new folder. Remember that folders contain all the reports related to a particular topic. For example, all reports related to Sales. You cannot create sub folders.

Creating a New Report from Existing Containers

This process consists of two steps:

- Adding a folder
- Adding a report

To add a folder

1. Open the *Sage 300 ERP Intelligence* Report Manager.
2. Select Home.
3. Right click and select **Add Folder**. The **Enter a Name for the Folder** window opens

![Add Folder](image)

4. Enter a name for your folder; e.g., Sales Test.
5. Click **OK**.

To add a report

1. Select the Folder where you want to add the report; e.g., Sales Test.
2. Right-click and select **Add Report**.
3. Select the type of report to add when prompted. You will add a standard report
4. Enter a new name for the report; e.g., Sales Report.

5. Click OK and the Select Data Container window opens.

6. Select the data container from which you want to source your data; e.g., Sales Details. The Choose Column fields window opens.

7. Select the columns you require in your report.

8. (Optional) Click Select All to select all of the Expressions.

9. Click OK. Your new report is now in your specified folder.
Sage 300 ERP Intelligence Report Properties

The report type (Standard, Dataless, Sub query or Union) mainly determines which standard tabs are available on the selected Properties window. A typical Properties window of Standard report types has, besides the Properties tab also a tab for each report output property, namely Columns, Filters, Parameters, Sort Fields, and Aggregate Filters.

Report Properties Overview

We will look at the properties and columns of a standard report.

When selecting a report, tabs appear on the right of the screen. These tabs allow you to modify the report’s display output.

Properties Tab

The Properties tab enables you to view and change general report details such as the report name and description. To confirm any change select the Apply button on the top right of the properties window.
Columns Tab
The columns window lists the columns that make up the Excel report. You are able to Add, Remove or change the order of the columns using the buttons on the top right of the window.
Adding Additional Columns

1. Select the **Columns** tab from the Properties window.

2. Click **Add**

   ![Report Manager GUI showing Columns tab]

3. Select the desired column; e.g., Document number.

   ![Choose Column Fields]

4. Click **OK**.

   The new column appears in the **Columns** window.
Moving and Deleting Columns

Moving Columns
If you want the columns to appear in a certain order in Microsoft® Excel®, you can change their order in the Properties window.

1. From the **Properties** window, select the **Columns** tab
2. Select the desired column/s
3. Click **Move Up** or **Move Down**

Deleting Columns

1. From the **Properties** window, right click on the desired column.
2. Click **Delete**.
or

1. From the **Properties** window, Click on the desired column.
2. Click **Remove**.
Creating a Simple Pivot Table in Excel 2007/ 2010

Four key reasons for organizing data into a Pivot Table are:

- To **summarise** the data contained in a lengthy list into a compact format
- To find **relationships** within the data that are otherwise hard to see because of the amount of detail
- To **organise** the data into a format that’s easy to chart
- **View** the same data in many **different** ways quickly and easily

Pivot Table reports use functions, allowing you to total, average and count data. These functions also provide subtotals and grand totals automatically, where you choose to show them.

**Original Worksheet**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Branch</td>
<td>SalesPerson</td>
<td>Category</td>
<td>Product</td>
<td>Date</td>
<td>Quantity</td>
<td>UnitPrice</td>
</tr>
<tr>
<td>2</td>
<td>East Coast</td>
<td>Anderson, P</td>
<td>Confections</td>
<td>Manulak</td>
<td>03/01/2006</td>
<td>30</td>
<td>18.00</td>
</tr>
<tr>
<td>3</td>
<td>East Coast</td>
<td>Johnson, A</td>
<td>Grains/Cereals</td>
<td>Grueschi di nonna Alice</td>
<td>01/01/2005</td>
<td>70</td>
<td>30.40</td>
</tr>
<tr>
<td>4</td>
<td>East Coast</td>
<td>Peters, K</td>
<td>Grains/Cereals</td>
<td>Tumbido</td>
<td>02/01/2006</td>
<td>60</td>
<td>7.20</td>
</tr>
<tr>
<td>5</td>
<td>East Coast</td>
<td>Borders, P</td>
<td>Confections</td>
<td>Flavours</td>
<td>03/01/2006</td>
<td>21</td>
<td>13.90</td>
</tr>
<tr>
<td>6</td>
<td>East Coast</td>
<td>Newton, L</td>
<td>Grains/Cereals</td>
<td>Singaporean Hokkien Fried Mee</td>
<td>03/01/2006</td>
<td>40</td>
<td>11.20</td>
</tr>
<tr>
<td>7</td>
<td>East Coast</td>
<td>Lawn, T</td>
<td>Seafood</td>
<td>Boston Crab Meat</td>
<td>07/01/2006</td>
<td>2</td>
<td>45.70</td>
</tr>
<tr>
<td>8</td>
<td>East Coast</td>
<td>Perkins, M</td>
<td>Seafood</td>
<td>Mnlgd Sll</td>
<td>07/01/2006</td>
<td>5</td>
<td>15.20</td>
</tr>
<tr>
<td>9</td>
<td>East Coast</td>
<td>Anderson, P</td>
<td>Beverages</td>
<td>Chai</td>
<td>07/01/2006</td>
<td>10</td>
<td>14.40</td>
</tr>
<tr>
<td>10</td>
<td>East Coast</td>
<td>Johnson, A</td>
<td>Dairy Products</td>
<td>Goudbrandskaas</td>
<td>07/01/2006</td>
<td>15</td>
<td>26.80</td>
</tr>
<tr>
<td>11</td>
<td>East Coast</td>
<td>Peters, K</td>
<td>Dairy Products</td>
<td>Gooes Celbrals</td>
<td>03/01/2006</td>
<td>30</td>
<td>16.80</td>
</tr>
<tr>
<td>12</td>
<td>East Coast</td>
<td>Borders, P</td>
<td>Beverages</td>
<td>Chai</td>
<td>14/01/2006</td>
<td>24</td>
<td>14.40</td>
</tr>
<tr>
<td>13</td>
<td>East Coast</td>
<td>Newton, L</td>
<td>Confections</td>
<td>Testime Chocolate Biscuits</td>
<td>16/01/2008</td>
<td>20</td>
<td>7.39</td>
</tr>
</tbody>
</table>

**Pivot Table**

**Pivot Chart**
Pivot Table Concept and Layout

Excel 2007/2010 Concept and Layout

An important point to remember when working with Pivot Tables is that you are working within a layout slightly different to a normal Microsoft Excel worksheet. A Pivot Table has its own Ribbon and that alone provides functionality specific to the Pivot Table and not to a normal Microsoft Excel cell on the worksheet.

Although one can format a cell using the format tools on the Home tab of the Ribbon, a Pivot Table provides its own format cells option on its Ribbon as it is treated as a separate entity.

A Pivot Table has its own layout and is split up into 4 sections.
Each of the above sections is used to show fields from the Pivot Table source data, each section having its own purpose.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Filter</td>
<td>This section assists in providing a <strong>third dimension</strong> to your data. It can also provide a more <strong>summarised/filtered</strong> view of the rest of the fields displayed in the other sections. When placing a field in this section it therefore <strong>reduces</strong> the number of items within a Pivot Table and in some instances prevents the Pivot Table’s number of <strong>items</strong> limitation from being reached. If you <strong>include a page field</strong> in your Pivot Table you can choose to display the Pivot Table pages on <strong>separate worksheets</strong>. Select the <strong>show pages</strong> button on the drop down menu of the Pivot Table <strong>toolbar</strong> button. Microsoft Excel will automatically replicate each page’s data on a separate worksheet.</td>
</tr>
<tr>
<td>Column Labels</td>
<td>One would place <strong>fields</strong> in this section when wanting to <strong>group</strong> the data by a specific field e.g. by customer. Your customers will appear in the <strong>columns going across</strong>.</td>
</tr>
<tr>
<td>Row Labels</td>
<td>One would place <strong>fields</strong> in this section when wanting to <strong>group</strong> the data by a specific field. E.g. by Customer. Your customers will appear in the <strong>rows going down</strong>.</td>
</tr>
<tr>
<td>Values</td>
<td>One would normally place <strong>fields</strong> in this section where their <strong>values</strong> are numbers such as a <strong>qty</strong> or <strong>amount</strong> field e.g. Customer Sales. Calculations such as <strong>sum, average, min, max</strong> etc. can be used on such fields. This section has to contain at least one field.</td>
</tr>
</tbody>
</table>

**Create a Pivot Table Report**

To create a Pivot Table you need to identify these two elements in your data:

- Have a list in Microsoft Excel with data fields (headings) and rows of related data
- Identify which fields are going to go where in your design

**Method**

1. Select any cell in the data list
2. From the **Insert** tab, in the Tables group, select **Pivot Table**
3. Make sure that **Select a table or range** is selected. When pivoting data from a source data sheet where the data was rendered by Sage Intelligence, always use the named range `Sheetname!RawData`. This will ensure that the full range of data extracted is always available for use within the pivot table. When adding new columns to a report, these new columns of data will then automatically be included in the pivot table range.

4. Make sure your data is listed in the **Table/Range** box.

5. Select where you want the Pivot Table to go, either in an **Existing Worksheet** or **New Worksheet**. **Note** if you choose New Worksheet it will be placed in front of Sheet1. You will need to move it after Sheet 1 & 2 so that it is not overwritten next time you run the report.

6. Select **OK**

7. A blank Pivot Table will now be displayed.
8. In the **Field List** either select the fields you want in the **Row Labels** or drag them into the **Row Labels** area on the **Field List** box

9. Repeat for **Report Filter**, **Columns Labels** and **Values**.

**Pivot Table Field List**
The Pivot Table Field List contains the fields available for your Pivot Table, based on the fields in the data range that the Pivot Table is based on. In addition there are areas where you can add Report Filter (Page Area fields), sections that list the row and column fields and a section for the Data Area fields.

**Turn the Field List On/Off**
The **Pivot Table Field List** is only visible while you are within the Pivot Table. If you are within the Pivot Table and it is still not visible, right click and select **Show Field List**. You can also turn the field list on and off from the Ribbon.

**Method**

1. Select any cell in the Pivot Table

2. From the **Options** tab, in the **Show/Hide** group, select **Field List**

OR
1. Select any cell in the Pivot Table

2. Right click and select **Show Field List**

**Remove, add and move fields**

When selecting a field from the data area to move or remove, you need to select the field by placing the mouse pointer on the border of the field and clicking when the pointer changes to the normal arrow pointer.

Fields that appear in the Pivot Table will have a tick in their check box on the Field List. De-selecting this check box will remove the field from the Pivot Table.

**Remove a Field**

**Method**

1. From the **Field List** select the check box next to the field you wish to remove

OR

1. From the **Field List**, select the drop down arrow next to the field

   1. Select **Remove Field**

**Add a Field**

**Method**

1. Select the check box next to the field in the **Field List**

OR

1. Select the Field in the **Field List** and drag it to the desired area e.g. Report Filter
Move Fields within the Table

Method

1. From the Field List, drag the field to the desired area

OR

1. From the Field List, select the drop down arrow next to the field

2. Select Move Up, Move down etc.
Pivot Table Concept and Layout 2003

Excel 2003 Concept and Layout

An important point to remember when working with Pivot Tables is that you are working within a layout slightly different to a normal Excel worksheet. A Pivot Table has its own toolbar and that alone provides functionality specific to the Pivot Table and not to a normal Excel cell on the worksheet.

Although one can format a cell using the format menu, a Pivot Table provides its own format cells option on its toolbar as it is treated as a separate entity.

A Pivot Table has its own layout and is split up into 4 sections. With reference to the diagrams below you can see the layouts in two different ways. The one on the left being the layout which is visible on the Excel worksheet, the one on the right being the same layout but with its appearance when working within the Pivot Table Wizard.
Each of the above sections are used to show fields from the Pivot Table source data, each section having its own purpose.

<table>
<thead>
<tr>
<th>The Row Area</th>
<th>One would place fields in this section when wanting to group the data by a specific field. e.g. by Customer. Your customers will appear in the rows going down.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Data Area</td>
<td>One would normally place fields in this section where their values are numbers such as a qty or amount field e.g. Customer Sales. Calculations such as sum, average, min, max etc. can be used on such fields. This section has to contain at least one field.</td>
</tr>
<tr>
<td>The Column Area</td>
<td>One would place fields in this section when wanting to group the data by a specific field e.g. by customer. Your customers will appear in the columns going across.</td>
</tr>
<tr>
<td>The Page Area</td>
<td>This section assists in providing a third dimension to your data. It can also provide a more summarized/filtered view of the rest of the fields displayed in the other sections. When placing a field in this section it therefore reduces the number of items within a Pivot Table and in some instances prevents the Pivot Tables number of items limitation from being reached.</td>
</tr>
</tbody>
</table>

Create a Pivot Table Report
To create a Pivot Table you need to identify these two elements in your data:

- Have a list in Excel with data fields (headings) and rows of related data
- Identify which fields are going to go where in your design

Method
1. Select any cell in the data list
2. On the Menu bar select Data
3. Select Pivot Table and Pivot Chart Wizard.
4. Make sure that Microsoft Excel list or database is selected as the data to analyze
4. Make sure the kind of report is selected as Pivot Table. When pivoting data from a source data sheet where the data was rendered by Sage Intelligence, always use the named range Sheetname!RawData. This will ensure that the full range of data extracted is always available for use within the pivot table. When adding new columns to a report, these new columns of data will then automatically be included in the pivot table range
6. Select **Next**

7. Select the collapse icon in the range box

8. Select the data range on the worksheet that contains the source data

9. The selected range will appear in the range box

10. Select the collapse icon again to return to your active worksheet.
11. Select Next

12. On the next screen, select where you want to place the Pivot Table, select **New Worksheet**

13. Choose another cell if you do not want the current cell as the position on the worksheet

14. Select **Layout**

The Pivot Table and Pivot Chart Wizard – layout window appears

15. The column headings from the source data will now appear as fields on the right

16. Drag the fields to the relevant positions on the layout
17. Select **OK**

18. Select **Options**

19. Select your required options

20. Select **OK**

21. Select **Finish**

The Pivot Table will be now be displayed
Remove, add and move fields

When selecting a field from the data area to move or remove, you need to select the field by placing the mouse pointer on the border of the field and clicking when the pointer changes to the normal arrow pointer.

Remove a Field

Method

1. Select a Field and drag it outside of the Pivot Table area and drop it

OR

1. Right click on a Field
2. Select Hide

Add a Field

Method

1. Select a Field from the Field List
2. Drag it into the Pivot Table area and drop it in the appropriate position

OR

1. On the Pivot Table toolbar select Pivot Table
2. Pivot Table Wizard, select the Layout button
3. Drag the fields to the appropriate position

OR

1. Select the Field in the Field List
2. From the drop down, select the Area you would like to add it to
Exporting Reports

Reports can be exported from one system and imported into another. The export function creates a compressed file with an .al extension which can be imported into other systems. The uncompressed version of the file will create a file with the extension .alx.

1. From the Object window, right click on the desired report and select Export Report or click on Tools, Export Report.

2. Click OK

3. Select the Export folder when prompted.

4. Click Save.

You will get a message to confirm your Export Succeeded.
5. Click **OK**.

To import a Report into *Sage 300 ERP Intelligence* from an export file see Importing a Report.

**Importing Reports**

Reports can be **exported** from one system and **imported** into another. The export function creates a compressed file with an `.al_` extension which can be imported into other systems. The uncompressed version of the file will create a file with the extension `.alx`

Report export files (.alx files) and compressed export files (.al_ files - version 3.5 and later) created using the Export Report facility can be imported into *Sage 300 ERP Intelligence*. Using this facility, Reports can be created in one *Sage 300 ERP Intelligence* system and distributed to other *Sage 300 ERP Intelligence* systems.

1. Right-click on the Home object in the Object window and Select **Import Report** or click on **Tools**, **Import Report**.

![Image of Import Report window]

2. Select the report to be imported (with the _al extension) and click **Open**

3. In the **Import Report** window, select the required **Target Connection** (Connector)

4. Then select the Report Destination (the folder)
5. Click **Import**

6. Click **OK**.

7. Double-click on the **Sales Reports** folder to refresh.
Below is a list of the information that is supplied to you for an import and a description of each element:

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>The original name of the Report in the Source Sage 300 ERP Intelligence System</td>
</tr>
<tr>
<td>Created By Company</td>
<td>The Company that created the Export File</td>
</tr>
<tr>
<td>Report Container</td>
<td>The Source Container for the Report in the Source Sage 300 ERP Intelligence System</td>
</tr>
<tr>
<td>Creation Time</td>
<td>The Date and time that the Export File was created</td>
</tr>
<tr>
<td>Original Template Name</td>
<td>The name of the Report Template in the Source Sage 300 ERP Intelligence System</td>
</tr>
<tr>
<td>Template File Size</td>
<td>The size (in bytes) of the Report Template File</td>
</tr>
<tr>
<td>Original Connection Name</td>
<td>The name of the Source Data Connection in the Sage 300 ERP Intelligence Source System</td>
</tr>
<tr>
<td>Export Library Version</td>
<td>The Version of the Export Program Library used to create the export file</td>
</tr>
<tr>
<td>Import Library Version</td>
<td>The Version of the Import Program Library being used to perform the import</td>
</tr>
<tr>
<td>Target Connection</td>
<td>The Connection that you have selected as the Source for the new report that will be created by the import</td>
</tr>
<tr>
<td>Target Connection Type</td>
<td>The Source Connection Type of the Connection that you have selected as the Source for the new report that will be created by the import</td>
</tr>
<tr>
<td>Report Destination</td>
<td>The Report Manager Folder into which the new report will be imported</td>
</tr>
</tbody>
</table>